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Introduction

This manual is meant as a reference for the easyScan E-Line software. It
applies to software version 2.0. This manual consists of two parts. The
first part contains an explanation of the concepts behind the software
and the user interface. This part should be read entirely to understand
the software well. The second part is a reference of all menu commands
and dialog functions. It is organised in the same order as they occur in
the software menu. This part of the manual can be read bit by bit, when
a better understanding of specific functions of the software is needed.
Instructions for the day-to-day operation of the easyScan E-AFM and E-
STM are given in a separate Manuals, called E-AFM Operating Instruc-
tions and E-STM Operating Instructions respectively.

INTRODUCTION
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Concept

The easyScan software has several functions:

• controlling the Nanosurf E-AFM/E-STM hardware,

• storing the measurements and instrument settings in computer memory,
on disk or on paper,

• displaying the measurements,

• evaluating the measurements.

These functions can be accessed via the easyScan user interface, which is
called ‘workspace’. In the following, the workspace will be explained
first, then the actual functions of the software will be discussed in more
detail.

The workspace
 The workspace of the easyScan software consists of three parts:

1. the main window,

2. measurement document windows,

3. control panels.

These parts are shown in the figure Parts of the easyScan workspace. The
arrangement of these windows and panels, and the way the measure-
ments are displayed can be saved and loaded to a file by the user (see
section Menu File, Workspace in the reference part of this manual).

The main window is opened as soon as the easyScan software starts. It
gives access to the whole functionality of the easyScan software. This is
done via the usual windows user interface items, such as a menu, a tool
bar and a status bar.

Measurement document windows are windows inside the main window
that visually represent previously made measurements.  They are created
when you decide to keep the current measurement result. The measure-

CONCEPT
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ment documents are used for storing, loading, printing and evaluation
of the measurements. The measurement document is described in more
detail in the section Data representation.

Control Panels

Scan Panel

Approach Panel

Feedback Panel

Spectroscopy Panel
...

Measurement
 Documents

Main Window

Parts of the easyScan workspace

Control panels are independent dialog windows that give quick access to
specific functions of the easyScan software. They can be opened via the
menu, or by using their short-cut keys. The Control panels allow you to
control the instrument operation (described in section Measurement),
change the measurement document windows, and perform evaluations.

The control panels allow you to operate the easyScan software by click-
ing buttons and by changing parameters using input boxes. Most con-
trol panels contain -buttons which give access to less often used
parameters. Using , all parameters are made available.  removes the
additional parameters.

The parameters in the control panels can be adjusted in several ways:

• Activate any input by clicking in it with the mouse pointer, or by
selecting it with the Tab-key.

CONCEPT
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• The value of an activated input can be increased and decreased using
the up and down arrows on the keyboard. The new value is automati-
cally used after one second.

• The value of a numerical input can also be increased and decreased by
clicking the arrow buttons  with the mouse pointer. The new value
is automatically used after one second.

• The value of an active numerical input can be entered using the key-
board. The entered value must be confirmed by pressing the ‘Enter’
or ‘Return’ key, or by clicking  with the mouse pointer.

• The alternatives in a drop-down menu (e.g.: ) can be se-
lected using the mouse. The selected value must be confirmed by
pressing the ‘Enter’ or ‘Return’ key, or by clicking  with the
mouse pointer.

Sometimes after entering a value, the program changes it to a slightly
different value. This happens when the desired setting cannot be per-
formed by the electronics due to the resolution limit of the analog-dig-
ital converter. The desired value is automatically changed to the nearest
possible value.

Controlling the E-STM/AFM hardware
The easyScan software allows the user to control the E-STM/AFM hard-
ware via several control panels. The settings in the control panels are
translated to hardware commands. These commands are either sent to
the easyScan E-SPM electronics through the serial port (also COM-port
or RS232 port) of your computer, or they are sent to a microscope simu-
lator software module. This simulator module can be used for exploring
the easyScan software.

Each of the panels controls a specific instrument function. Some panels
control the measurement, others are used to prepare a measurement.

The following panels are used to control the measurements:

• Scan Panel: generates ‘topographical’ images.

• Spectroscopy Panel: generates force distance curves.

CONCEPT
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• Feedback Panel: settings for feedback loop parameters.

The ‘Approach Panel’ is used to control the tip-sample approach before
measuring. Finally, with the E-AFM, the toolbar allows you to control
the lighting and the (optional) video camera of the optical microscope .

Storing measurements
Data generated by a measurement is stored in the computers memory.
The acquired data is grouped and collected to form a measurement docu-
ment. A measurement document consists of the settings used to obtain
the measurement, and measured data (see figure Measurement document).

The measured data is grouped according to the type of scan with which
it was obtained. The measurement document contains one or more of
the data types ‘ForwardScan’, ‘BackwardScan’, ‘Spectroscopy’
‘ForwardSpec’, ‘BackwardSpec’, and ‘CrossSection’ among others.

• The data of the types ‘ForwardScan’ and ‘BackwardScan’ is obtained
using the ‘Scan Panel’.

• The data of the types ‘ForwardSpec’ and ‘BackwardSpec’ is obtained
using the ‘Spectroscopy Panel’. These types consist of one or more
spectroscopic measurements, each made in a different position along
a line in the xy-plane. The obsolete data type ‘Spectroscopy’ is identi-
cal to ‘ForwardSpec’

• The data of the type ‘CrossSection’ is obtained using the ‘Cross-Sec-
tion’ tool.

Each of the data types contains one or more input channels. The  chan-
nels available depend on the measurement mode, as shown in the table
in section Scan Panel, parameter ‘meas.’. Additional channels may be
available with future extensions of the hardware. The names of the input
channels can be changed using the dialog ‘Scan Head Calibration’ (see
section Options in the Functional Reference part of this manual).

CONCEPT
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DataType:
ForwardScan

Measurement Document

ZOutput Other InputLeverSig.

DataType:
BackwardScan ZOutput Other InputLeverSig.

DataType:
Spectroscopy Other InputLeverSig.

Data Info

Example of a storage structure of a measurement document

There are several options for exporting the data stored in computer
memory: they can be stored on disk in different file formats or they can
be printed on paper. All of these storage functions can be accessed via the
file menu (see section Menu File in the reference part of this manual).

Displaying the measurements
Measurements are displayed in so called ‘Views’. These views are found
in certain Control panels, and in Measurement document windows. The
behaviour of the Measurement document windows is described here,
the behaviour of the control panels is in many ways the same.

The name of the file in which the measurement document is stored, is
shown at the top of the Measurement document window. Each of the
views in the measurement document is connected to one data type and
input channel. Other properties of the view are the type of preprocess-
ing performed on the data (‘LineMath’) and the type of display. Avail-
able display types are ‘LineView’, ‘TopView’, ‘3DView’ and ‘ShadeView’.
The displayed line in all LineViews can be selected by dragging the
arrow on the right of a TopView- or ShadeView- type display (See figure
Elements of a View). The easyScan software allows the saving and loading
of the settings for the displayed measurement documents and panels
(see Menu File, Workspace in the reference).

CONCEPT
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Input channel LineMath View type

Data type

Line
selection

arrow

Color-bar

Elements of a View

The ‘View Panel’ is used to create new views in the active document
window, or to modify the properties of the active view. Both Measure-
ment document windows and views are activated by clicking them with
the mouse cursor.

The ‘Data Info Panel’ is used to display the measurement settings of the
currently active measurement document.

The functions of the View Panel and the Data Info Panel are described in
the section Panels of the Functional Reference.

CONCEPT
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Connects a view to 
the measured data

Displays information
DataType:
ForwardScan

Measurement Document

ZOutput Other InputLeverSig.

DataType:
BackwardScan ZOutput Other InputLeverSig.

DataType:
Spectroscopy Other InputLeverSig.

Data Info

Displaying Measurements: Schematic representation of the data collection of a measurement

Evaluating measurements
Features of the measurements can be evaluated numerically using the
evaluation tools. The tools are activated via the corresponding menu
item or by the respective button in the tool bar. The tools can be used in
all views, both during measurement and off-line. The current status of
an evaluation tool is displayed in the ‘Tool Info Panel’. More informa-
tion on the evaluation tools can be found in the functional reference part
of this manual.

CONCEPT
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Functional reference

In this part of the manual, all the software functions of the easyScan E-
Line software are described. The functions are in the same order as they
are found in the menu in the main window.

Menu File
Menu entry ‘File’ contains the items for opening , closing, saving

, printing  the measurement documents and for exiting the pro-
gram. In the following only the special functions are mentioned.

    

‘Save’ and ‘Save as...’
Using the menu options ‘Save’ and ‘Save as...’ , you can store measure-
ment documents in the easyScan data format (file extension .ezd).

You can open such a .ezd file by double clicking it with the mouse in the
Windows explorer. The ‘easyScan’ program is started automatically and
the data can be analysed. You can also open one or more files by drag-
ging them into the main window.

FUNCTIONAL REFERENCEMENU FILE

‘SAVE’ AND ‘SAVE AS...’
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Export ->View as / DataSet as
With these functions either the active view is saved or the whole active
measurement document is saved as a bitmap (.bmp), data file (.dat),
plot file (.plt) or comma separated values (.csv) for use in other programs
or image processing software (see also chapter ‘Programs for further data
processing’).

Windows Bitmap (.bmp)

A Windows Bitmap image is suitable for including in documents, e.g.
word or image processing software . The exact image as seen on the com-
puter screen will be saved in the file (‘screen shot’).

Data file 8Bit (.dat)

A binary data file can be processed in image processing software.

This ‘binary’ data format contains only the measured data. The data is stored
consecutively line by line upwards as 8-bit values (0-255). The data is stored
using the settings chosen in the ‘LineMath’ section of the ‘View Panel’.
If the display mode ‘LineView’ is selected in the ‘View Panel’ only the
displayed line will be saved.

FUNCTIONAL REFERENCE MENU FILE

EXPORT ->VIEW AS / DATASET AS



15

Plotfile ASCII (.plt)

This is an ‘ASCII’ text format which contains the measured data as well
as a small header with a description of the scan. The data is stored using
the setting ‘LineMath’ in the ‘View Panel’. A measurement as a plotfile
can be used for detailed data analysis by various mathematics software
such as e.g. MathLab or plotted by GnuPlot.

• If ‘LineView’ is selected as ‘Display’ in the ‘View Panel’, only the
visualised lines will be stored. Each data point is stored as a pair of
floating point numbers on a separate line. The number pairs are sepa-
rated by a blank character (SPACE).

• If any other view type is selected, all measured values are stored. All
values in a data line are stored on a separate line in the text file. An
empty line is inserted after every data line. The data lines are stored
from the bottom to the top. A small header at the beginning of the
first data line contains the names of the channel and frame, as well as
x-, y-, and z-ranges with their physical units.

If the actual data is stored using the function ‘Export->DataSet as..’,
then every ‘View’ in the measurement document is stored in the export
file consecutively. Whereby the settings as described above are used.

With the ‘binary’ format the blocks of data from each ‘View’ are stored
directly one behind the other.

With the ‘ASCII’ text format the blocks of data for each ‘View’ are sepa-
rated by two empty lines.

Comma separated values (.csv)

This format stores all the measured data as a matrix of floating point
numbers in ASCII format separated by a ‘comma’ and ‘SPACE’ charac-
ter. This enables easy data exchange with commonly used spread sheet
and database applications.

Print, Print Preview
Prints the actual measurement document together with the values shown
in the ‘Data Info Panel’.

FUNCTIONAL REFERENCEMENU FILE

PRINT, PRINT PREVIEW
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The print Preview shows what the printed image will look like on screen.
The following figure shows a print preview of a typical measurement. In
addition to all the views, further information is provided on the print-
out.

Workspace
When the ‘easyScan’ program is started some of the panels appear at
predefined places on the computer’s screen, and the measurement dis-
plays contain certain views. This arrangement of the ‘workspace’ is stored
in the configuration file ‘Default_E-STM.ezw’ or ‘Default_E-AFM.ezw’
by default. The location of the settings files on the hard-disk depends on
the operating system you use.

Using ‘Save as...’, you can save your own arrangement of the panels un-
der another name if desired.

Using ‘Load’, you can load predefined arrangements of the panels.

FUNCTIONAL REFERENCE MENU FILE

WORKSPACE
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Important!

With ‘Save’ you directly overwrite the original configuration file
‘Default_E-STM.ezw’ or ‘Default_E-AFM.ezw’ with the current arrange-
ment of the panels .

If the default file is missing, the ‘easyScan’ main window remains empty
after program start. If a panel is opened it opens in the centre of the
main window.

Parameters
All the panels parameters are stored in a configuration file with the ex-
tension ‘.ezs’. When the E-Line software is started, default values are
loaded which are stored in the file named ‘Default_E-STM.ezs’ or
‘Default_E-AFM.ezs. The location of the settings files on the hard-disk
depends on the operating system you use.

Using ‘Save as...’, altered settings can be stored under a new file name.
These settings can be loaded by ‘Load’.

Important!

With ‘Save’, you directly overwrite the original configuration file
‘Default_E-STM.ezs’ or ‘Default_E-AFM.ezs’ with your current settings.

If the default file is missing, the program inserts default values for all
parameters.

Menu Panels
A panel can be selected using the menu, the tool bar or using the ‘Ctrl’-
key and its corresponding function key.

     

FUNCTIONAL REFERENCEMENU PANELS

PARAMETERS
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Note that the grouping of the tool bar buttons corresponds to the grouping
of the function keys on the keyboard.

When a panel is selected it is opened, or it is brought into the fore-
ground if it is hidden behind other windows.

Approach Panel (E-AFM)
The tip to the sample approach is operated using the ‘Approach Panel’.

Status

Monitors the current status of the sensor approach.

Move

The following four buttons control the sensor approach drive:

: drives the sensor away from the sample at maximum
speed until the button is released.

: drives the sensor towards the sample at maximum
speed until the button is released.

: retracts the sensor from the sample by a predefined
time.

: starts the automatic tip to sample approach until
the force set-point, set in the feedback panel, is de-
tected.

FUNCTIONAL REFERENCE MENU PANELS

APPROACH PANEL (E-AFM)
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Automatic Move Configuration

Stepsize: The speed of the motor during the automatic ap-
proach is adjusted by the slider.

Important!

If the tip to sample approach is too fast, the tip or the sample surface can
be damaged. It is therefore recommended to use make ‘Stepsize’ as small
as possible. However, the motor will not move when ‘Stepsize’ becomes
too small (at a ‘Stepsize’ of approximately 3%).

Retries: The ‘Retries’ value defines how long the maximum
the automatic approach runs after clicking

.

Withdraw: The ‘Withdraw’ value defines how long the tip is
retracted from the sample after clicking  .

Approach Panel (E-STM)
The tip to the sample approach is operated using the ‘Approach Panel’.
This is used to obtain a precise and reproducible sample to tip approach.

Position

The Z-position of the motor is monitored by the number of steps per-
formed.

FUNCTIONAL REFERENCEMENU PANELS

APPROACH PANEL (E-STM)
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Steps: shows the number of steps taken.

: resets the ‘steps’ to zero.

Move

The following four buttons control sample holder’s motor:

: drives the sample holder away from the tip with the
maximum step size until the button is released.

: drives the sample holder towards the tip with the
maximum step size until the button is released.

: withdraws the sample from the tip by a predefined
number of steps.

: approaches the sample surface toward the tip until
the tunneling current set-point, set in the feedback
panel, is detected.

Automatic Move Configuration

Stepsize: The stepsize of approach motor during the automatic
approach is adjusted by the slider.

Important!

If the step size of the tip to sample approach is too large, the tip can be
damaged. It is therefore recommended to use make ‘Stepsize’ as small as
possible. However, the motor will not move when ‘Stepsize’ becomes
too small (at a ‘Stepsize’ of approximately 50%).

Retries: The ‘Retries’ value defines the maximum number of
steps the automatic approach runs after clicking

.

Withdraw: The ‘Withdraw’ value defines the number of steps
the sample is retracted from the tip after clicking

.

FUNCTIONAL REFERENCE MENU PANELS

APPROACH PANEL (E-STM)
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Scan Panel
The ‘Scan Panel’ is the control centre of the instrument. Here the most
important measuring parameters are set and the acquired data is dis-
played. The whole scan panel is divided in three parts (see figure Scan
Panel): scan control, data views and parameter fields.

After starting the program (with the default workspace) two areas appear
in the centre of the ‘Scan Panel’ in which the measured data are dis-
played. The data can be viewed in several ways simultaneously depend-
ing on the setting in ‘View Panel’.

The ‘Scan Panel’ can be changed in size. This enables the representation
of any number of data views even during scanning. The size of the ‘Scan
Panel’ is changed using the mouse pointer. New views are added to the
‘Scan Panel’ using  in the ‘View Panel’. The attributes of the new
views are defined using the ‘View Panel’.
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The scan panel
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We recommend having at least two displays, one a section (‘Line View’)
of the scan surface (showing the actual scan line) and one topographical
(‘Top View’).

Start/Stop, Finish, Up, Down

In the upper part of the ‘Scan Panel’ are the buttons to control the scan.

/ :  starts a measurement and then changes to .
This is button can then used to abort the measure-
ment immediately.

: After using  the measurement stops when the
bottom (or top) of the image has been reached.

/ : With  the image is scanned from the bottom to
top, with  it is scanned from the top to the bot-
tom.

If a scan has been started using  or  the measurement stops auto-
matically after one full image .

Zoom

With  a smaller area can be measured in more detail. The area of the
zoom is defined by dragging the mouse pointer over an area in a ‘TopView’
while holding down the left mouse button. Once an area is defined, it
can be resized by dragging one of its corners, and moved to the desired
position by dragging its centre point.

  

FUNCTIONAL REFERENCE MENU PANELS

SCAN PANEL



23

The ‘Tool Info Panel’ shows the size and position of this new area and
the cursor position. A double click with left mouse button in the view,
or clicking  in the tool info panel, modifies the parameters
‘ScanRange’, ‘X-, Y-, Z-Offset’ in ‘Scan Panel’ accordingly. When the
zoom function is active it can be aborted either by clicking  again or
by clicking with the right mouse button.

If just a single mouse click is performed in the active ‘View’, a square
33% of the full area is generated.

Full

 returns the parameters ‘ScanRange’ and Z-range to the largest
possible values, and the  ‘X-’, ‘Y-’, and ‘Z-Offset’ to zero.

Move

With  you can move the image. An interesting corner can thus be
moved to the centre of the picture. The change in the position is indi-
cated by an arrow. This arrow is defined by pressing the left mouse but-
ton and dragging the mouse pointer along a line then releasing it. The
image is moved from its original position to the newly chosen one by
double clicking, or clicking  in the ‘Tool Info Panel’. The move
function can be aborted either by using  again or by clicking with
the right mouse button. A single mouse click in the active ‘View’ pro-
duces an arrow from the actual pointer position to the centre of the
‘View’.

  

FUNCTIONAL REFERENCEMENU PANELS

SCAN PANEL
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Spec

By using   the current measurement is interrupted and the actual
data is transferred to the ‘Spectroscopy Panel’, which opens automati-
cally. It is advisable to use  to complete the current scan before start-
ing the spectroscopy measurement.

Force-distance, or tunneling current-distance experiments are performed
using the ‘Spectroscopy Panel’.

Photo

Clicking  captures the current measurement displayed in the ‘Scan
Panel’ in a measurement document, and displays it in a separate win-
dow. The scanning continues automatically.

If  is clicked during the scan, a copy is generated when the actual
measurement is finished. During the scan the button remains pressed.
The capture process is cancelled by clicking  a second time.

To capture an image without waiting for the scan to be completed, stop
the scanning by clicking . The image can then be captured immedi-
ately by clicking .

The measurement documents are labelled automatically with increasing
numbers (i.e. ezData1.ezd, ezData2.ezd, ...). When leaving the program
you will be asked if you want to save the unsaved measurement docu-
ments.

Standard parameters

Z-Range/InputRange: determines the range of possible data values of
the currently active view of the scan panel. When
the active view displays height data, the name of the
input is ‘Z-Range’, otherwise it is ‘InputRange’.
When the value of ‘Z-/InputRange’ is reduced, the
signal is amplified. This allows observing small fea-
tures on a surface .

FUNCTIONAL REFERENCE MENU PANELS

SCAN PANEL
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ScanRange: fixes the scan size in x and y direction where (x=y).
The value is doubled or halved when using  .

Time/Line: sets the time taken to acquire a data line.

The plane on which the tip is scanned (scan-plane) can be aligned to the
surface of the sample using the next three parameters (also see schemat-
ics):

Z-Offset: shifts the scan-plane in z-direction. This parameter
can only be used when ‘Auto adjust z-Offset’ in the
‘Options’ menu is turned off.

X-slope: A positive value tilts the x-axis of the scan-plane coun-
ter-clockwise.

Y-slope: tilts the y-axis of the scan-plane counter-clockwise
(when viewed at 90° rotation).

When the scan-plane is correctly aligned, more accurate measurements
can be made, because a smaller z-Range can be used. In addition, the
error signal of the height feedback circuit is smaller because it does not
have to compensate for the scan-plane.

FUNCTIONAL REFERENCEMENU PANELS

SCAN PANEL
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Advanced parameters

If the advanced parameters are not available, they can be opened by
clicking .

Rotation: sets the clockwise rotation angle of the scanned area.

Samples: sets the number of measured data points per line.

The scanned area can be shifted by changing the x-/y-offset. The values
are always relative to the centre of the entire scan range:

X-Offset: sets the centre position of the measured area in x-
direction.

Y-Offset: sets the centre position of the measured area in y-
direction.

Measure: The options are ‘Backward’, ‘Forward’ or ‘Forw. &
Backw.’.

• ‘Forward’: data is acquired and stored during for-
ward scan only (left to right in the image).

• ‘Backward’: data is acquired and stored during
backward scan only (right to left in the image).

• ‘Forw.&Backw.’: data is acquired and stored dur-
ing both forward and backward scan.

ScanDir: The options are ‘Continuous’, ‘Cont.Up’ or ‘Cont.
Down’:

• ‘Continuous’: data is acquired and displayed from
bottom to top and vice versa.

• ‘Cont.Up’: data is acquired and displayed from bot-
tom to top.

• ‘Cont.Down’: data is acquired and displayed from
top to bottom.

FUNCTIONAL REFERENCE MENU PANELS
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Meas. Determines which input channels are measured.
When the option ‘Ch0+1’ is selected, logical input
channel 0 and 1 are measured, when the option
‘Ch1+2’ is selected, input 1 and 2 are measured.
Usually, only ‘Ch0+1’ is available, unless the sec-
ond channel option is installed (see section Options,
Access codes...). The mapping of the physical input
channels on the logical channels 0..2 depends on
instrument, as given in the table below. For more
information of the signal mapping see the section
Menu options, Scan head calibration.

Channel 0 Channel 1 Channel 2

E-AFM LeverSig ZOutput User Signal (optional)

E-STM Current ZOutput User Signal (optional)

Feedback Panel
To scan the sensor across the sample’s surface the distance between tip
and sample must be controlled. In Atomic Force Microscopy the control
parameter is the interacting force between tip and sample, in Scanning
Tunneling Microscopy it is the tunneling current.

The parameters of the feedback loop and the feedback force/current are
set in the ‘Feedback Panel’:

    

Feedback Panel: Setting the feedback loop parameters, left: for E-AFM, right: for E-STM

SetPoint: sets the working point for the feedback loop. De-
pending on the instrument, this will be a force (E-
AFM), or a current (E-STM).

FUNCTIONAL REFERENCEMENU PANELS

FEEDBACK PANEL
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P-Gain: sets the speed of the proportional feedback loop. In-
creasing P-Gain by one doubles the speed of the feed-
back loop.

I-Gain: sets the speed of the integrative feedback loop. In-
creasing I-Gain by one doubles the speed of the feed-
back loop.

If  the Gain is set to 0, the feedback loop is switched off. When the Gain
is set to 16, it has maximum speed. If the gain is too low, the feedback
loop will not follow the surface fast enough. Thus, the image will not be
as sharp as it could be. If the gain is too high, the feedback loop will
overshoot and may start to oscillate. Thus, the image will contain many
measurement artifacts.

TipVoltage (E-AFM): sets the potential to be applied to the tip. The
usable voltage range is between -10V and +10V. Note
that the sample has to be electrically connected to
the instrument chassis ground for accurate measure-
ments.

GapVoltage (E-STM): sets the voltage of the tunneling gap between tip
and sample [V]. A positive ‘GapVoltage’ means that
the tip has a positive potential relative to the sam-
ple’s surface and hence the electrons tunnel from
the sample to the scanning tip.

: restores the default values. These settings can be used
to measure the microstructure sample with the E-
AFM, and graphite with the E-STM.

Advanced options

Running: the feedback loop of the Z-distance controller is ac-
tive.

Stop: turns off the Z-distance controller. The tip is fixed
in the actual Z-position relative to the scan-plane
defined by X- and Y-Slope.

FUNCTIONAL REFERENCE MENU PANELS

FEEDBACK PANEL
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Stop & Clear: turns off the Z-distance controller. The tip’s Z-posi-
tion is set to the actual ‘Z-Offset’ position relative
to the scan-plane defined by X- and Y-Slope.

Important:

If the z-offset is much lower than the current position of the tip, or the
scan range contains large height differences, turning off the feedback
(and clearing it) will result in the tip crashing into the sample, damag-
ing the tip!

View Panel
The way the data is represented in a ‘View’ can be controlled by the
‘View Panel’ attributes. The settings either refer to the actual active view
(highlighted) in the data display, or to a new view. It is possible to show
the same data in different ways using the ‘View Panel’ settings.

   

View Panel: setting of the view parameters

The following buttons control the creation and modification of the views.

: applies the current settings to the active view.

: uses the current settings to create a new view in the
active measurement document. The ‘Scan Panel’, or
the measurement document may have to be resized
to see all ‘Views’.
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: removes the active display.

DataType: depending on what is being measured or saved in a
measurement document (see Scan Panel, Parameter
‘Measure’), the data type that is shown can be cho-
sen here: ‘ForwardScan’, ‘BackwardScan’,
‘ForwardSpec’, ‘BackwardSpec’, or ‘CrossSection’.

Input: indicates which physical input channel is displayed.

• ‘ZOutput’:  the movement of the Z feedback loop.

• ‘LeverSig’:  the cantilever deflection signal (E-AFM).

• ‘Current’: the tunneling current (E-STM).

• ‘User Signal’: a user definable input signal. (Op-
tional)

The available input channels signals depend on the
measured logical input channels and on the currently
selected data type (see Scan Panel, Parameter ‘Meas.’).
Note that the names of the physical channels can be
changed in the ‘Scan Head Calibration’ dialog.

LineMath: defines the processing of data before it is displayed:

• ‘Raw’: raw data without any processing.

• ‘Average’: an average is subtracted from data points.

• ‘Plane’: an inclined plane is subtracted from data.

• ‘Derive’: difference between two successive data
points (derivative).

• ‘Parabola’: a second order polynomial is subtracted
from data.

• ‘PolyFit4’: a fourth order polynomial is subtracted
from data.

Display: sets the display mode:

• ‘LineView’: data is displayed as x-z diagram (->con-
tour line).

• ‘TopView’: data is encoded in gray scale values in
xy-plane (-> ‘topography’).
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• ‘3D-view’: data is shown as a 3-dimensional repre-
sentation in a parallel perspective.

• ‘ShadeView’: creates a three dimensional impres-
sion of the surface with lighting from the left. This
is achieved by combining the topography with its
derivative

• ‘DualLineView’: both the Forward and the Back-
ward data (when available) are displayed as in the
‘LineView’. The  line of the data type selected in
‘DataType’ is black, the other type is grey.

When the display mode ‘LineView’ is selected, the Z-Range is auto-
matically set to full range.

Data represented using different display modes
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Visible Data Range:

The grey scale of an image is controlled by the settings in the ‘Visible
Data Range’ section. The actual colour mapping is represented as a color-
bar in the appropriate ‘Top View’ window.

    

Offset

Visible
Data

Range
Input

Range

Range: affects the ‘contrast’ of the image.

Offset: affects the ‘brightness’ of the image.

: expands the visible data range to the full input range.

: the software tries to find the optimum range and
offset for the active view using a histogram of the
measured data.

Advanced options

The amount of information in a ‘View’ is controlled by the attributes in
the ‘Display’ section:

Size: the size of the active view is defined by the value of
‘Size’.
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Pixel: If selected then the value in ‘Size’ indicates the im-
age size in pixels. The number of pixels should be an
integer multiple of the value ‘Samples’ (measured
points) in ‘Scan Panel’ or ‘Spectroscopy Panel’ in
order to avoid interpolation which could lead to
imaging faults (Moiré pattern)

Percentage: If selected then the value in ‘Size’ indicates the
number of pixels per measured point in percent: rec-
ommended is 100%, 200% or 300%.

Axes and labels: With this check box the labels in ‘Views’ and the
color-bar in ‘TopView’ window, can be switched on
and off.

Spectroscopy Panel
The ‘Spectroscopy Panel’ is used to perform spectroscopic measurement
sequences. In a spectroscopic measurement, the input channels are meas-
ured as a function of a modulated parameter.  This modulated parameter
can be the z-distance to the sample, or the tip-sample voltage difference.
(.... Note that you must electrically connect the sample to the chassis
ground of the instrument to apply a tip-sample voltage difference .) The
measured parameter can be any available input channel. Examples of a
spectroscopy measurement are force/distance curves with the E-AFM, or
current/voltage curves with the E-STM. The accuracy of the spectroscopic
measurements can be increased by averaging the measurement results of
several consecutive modulations.

A spectroscopic measurement sequence consists of one or more
spectroscopic measurements of the same type, measured on a user de-
fined number of points along a line in the xy-plane. A point measure-
ment is made if the number of points is one. The measurement sequence
is carried out as follows:

1. The tip is moved with active feedback to the start of the line.

2. The feedback loop is switched off.

3. A spectroscopic measurement is recorded.
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4. The feedback loop is turned on again.

5. The tip is moved to the next point on the line in the xy-plane.

Steps 2.-5. are repeated for each points on the line.
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The spectroscopy panel is divided in three parts: scan control, data views
and parameter fields. When the spectroscopy panel is activated from the
‘Scan Panel’, a new measurement document is created, and the last meas-
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ured scan is transferred to the spectroscopy panel. When activated using

the menu item or the function key ‘F4’ or clicking  in the tool bar,
the panel is opened without data transfer.

Start/Stop

 starts a measurement and then changes to . This is button can
then used to abort the measurement immediately.

Point/Line

The points where a spectrum is to be taken are defined using the mouse
after clicking  or .

If a ‘TopView’ window is selected a point (click ) or line (click )
can be drawn using the mouse pointer. Clicking only once with the
right mouse button generates a small square (point) or arrow (line) point-
ing to the centre of the view.

When  is selected, an arrow can be drawn by clicking and dragging
with the mouse. After marking the coordinates they are transferred to
the appropriate fields in the lower part of the ‘Spectroscopy Panel’ by
double clicking the left mouse button, or by clicking  in the ‘Tool
info Panel’.

Clicking with the right mouse button aborts the function.

Photo

 generates a copy of the measurement document (image and data)
which now also contains spectroscopic data, i.e. besides ‘ForwardScan’
and ‘BackwardScan’, also ‘ForwardSpec’ and ‘BackwardSpec’ appear as
‘DataType’ in ‘View Panel’.

Parameters
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If only some of the parameter fields are visible, the ‘Spectroscopy Panel’
can be extended using .

Output: Sets the modulated output to be either ‘TipVoltage....’
or ‘Z-Axis’. This output is modulated according to
the configuration of the spectroscopy measurement.

Averages: Sets the number of times the modulation is repeated
to obtain one averaged spectroscopic measurement.

Rel. If this check box is selected, the ‘Output’ is varied
relative to the actual value of ‘TipVoltage’ or ‘Z-Axis’.
If the ‘Z-Axis’ is modulated, the measurement z-po-
sition is relative to the sample surface when ‘Rel.’ is
selected. The measurement z-position is relative to
the xy-plane when ‘Rel’ is not selected.

From/To: Sets the range between which the modulation ‘Out-
put’ varies. The modulation starts at ‘From’ and ends
at ‘To’.

Time/Mod.: Sets the duration of a single spectroscopy measure-
ment. Within this time the ‘Output’ is varied be-
tween ‘From’ and ‘To’.

Samples: Sets the number of measurement points in one
spectroscopic measurement. The measurement po-
sition are equally distributed over the modulation
range.

Advanced parameters

Spectroscopy Line:

The following parameters are used to define a spectroscopic measure-
ment sequence:

X-From/Y-From: Sets the xy-coordinates of the measured point in a
-spectroscopy measurement. Sets the xy-coordi-

nates of the starting point of the line in a -spec-
troscopy measurement sequence.
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X-To/Y-To: Sets the xy-coordinates of the endpoint of the line
in a -spectroscopy measurement sequence. These
coordinates are indicated by the arrow.

Points/Line: Sets the number of points at which spectroscopic
measurements are to be measured in a -spectros-
copy measurement sequence. The measurement po-
sitions are equally distributed over the line.

Input Level:

The settings of ‘Input Level’ have two functions. First they have the
same function as ‘Z-Range/InputRange’ in the ‘Scan Panel’. Addition-
ally these settings are used to limit the safe range of the measured values.
If the measured parameter surpasses this range, the measurement is
aborted to prevent damage to the tip.

Range: Sets the maximum range of the measured input chan-
nel.

Offset: Sets the centre level of the range.

Mod./Point/Spec.: determines what is to be done if the range is sur-
passed and the measurement aborted:

• ‘Mod’ - aborts the current modulation period, and
continues with the next modulation until the
number of modulations in ‘Averages’ is reached.

• ‘Point’ - aborts the spectroscopy measurement for
the current point and continues with the next
point of the line, if a  spectroscopy is being
performed.

• ‘Spec.’ - aborts the entire spectroscopy measure-
ment sequence (cancels all ‘Averages’ and points).

When a spectroscopy measurement has been aborted, a warning sign 
is displayed in the ‘Spectroscopy Panel’. The number of aborts that oc-
curred in a measurement is reported in ‘Data Info Panel’ as:
ModAborted=<number of aborts>.
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Data Info Panel
‘Data Info Panel’ displays the parameters of the active measurement docu-
ment. This panel contains a list of the measurement parameters.

  

Left: the parameters of a measurement, as shown in the ‘Data Info Panel’. Right: the
parameters of a spectroscopic measurement are added to the parameter list.

Tool Info Panel
The ‘Tool Info Panel’ monitors the xyz-mouse coordinates in the scan-
coordinate system and the results of the function which is being per-
formed.

If ‘Popup’ is activated the Tool Info Panel is only visible while a function
is performed which needs the coordinates displayed (e.g. zoom).

Clicking  carries out the function of the current tool. This has the
same effect as double clicking into the view in which the tool is used.

FUNCTIONAL REFERENCE MENU PANELS

DATA INFO PANEL



39

Result Panel
The ‘Result Panel’ displays calculated values generated by a tool. The
displayed information can be stored in the ‘data info’ part of the corre-
sponding measurement by clicking  .

     

When ‘PopUp’ is activated, the ‘Result Panel’ is only visible while a
function is being performed that needs its results displayed.

Menu Tools
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Properties of the measurements can be evaluated numerically using the
tools. The tools are activated via the corresponding menu item or by
clicking the respective button in the tool bar. Tools can be used in all
views, both during measurement and off-line.

Important!

All these results are calculated after the ‘LineMath’ has been applied to
the data. The results will generally vary when a different ‘LineMath’
option is used.

Measure Length

Using the ‘Measure Length’ tool  you can define two points. The
distance between them is shown in the ‘Tool Info Panel’.

- Activate the image to be analysed by clicking onto it with the mouse
and then click  or select the menu entry respectively.

- A double ended arrow can be drawn on the data display by holding
down left mouse button and dragging the mouse. The length of the
arrow is shown in ‘Tool Info Panel’.

The arrow can be adjusted by using the markings at each end and moved
with the middle point. Clicking without dragging generates an arrow
from the current position of the mouse pointer to the centre of the im-
age.
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The length measurement is aborted using the right mouse button or by

clicking  a second time.

Measure Distance

Using the ‘Measure Distance’ tool  you can define two parallel lines.
The distance between them is shown in the ‘Tool Info Panel’.

  

- Activate the image to be analysed by clicking onto it with the mouse
and then click  or select the menu entry respectively.

- A line can be drawn into the data display by holding down left mouse
button dragging with the mouse.

- After releasing the left mouse button a second parallel line sticks to the
mouse pointer and is ready to be positioned. The distance between the
two parallel lines is shown in the ‘Tool Info Panel’.

- The second parallel line is released by clicking the left mouse button.
The angle of both parallel lines can be adjusted by dragging their end
points. The lines are translated by dragging their centre.

The distance measurement is aborted by the right mouse button or click-

ing  a second time.
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Measure Angle

Using the ‘Measure Angle’ tool  you can draw an angle which is to be
analysed. The size of the angle drawn is shown in the ‘Tool Info Panel’.
This tool can only be used in a ‘LineView’-type display when it displays
height (‘ZOuput’) data.

- Activate the image to be analysed by clicking into it with the mouse
and clicking  or selecting the menu entry respectively.

- An angle can be drawn onto the active data display by clicking and
dragging with the mouse pointer. The corresponding size and position
of the angle is shown in the ‘Tool Info Panel’.

  

Both sides can be adjusted using the markings. The entire object can be
moved using the middle points.

The angle measurement is aborted by using the right mouse button or

by clicking  a second time.

Create a Cross-Section

The ‘Create a Cross-Section’ tool  enables you to view any cross-
section of the ‘TopView’. This cross section is shown simultaneously in
the ‘Tool Info Panel’ and can be stored in a new measurement document
(DataType: ‘CrossSection’).
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- Activate the image to be analysed by clicking into it with the mouse
and click  or select the menu entry respectively.

- Define a line with the  tool, by clicking and dragging while holding
down the left mouse button. The arrow tip at the end of the cross-
section indicates the direction of the cross-section.

The arrow can be modified in position, size and orientation after releas-
ing left mouse button.

The ‘Tool Info Panel’ show a view of the cross section and the values of
‘DeltaZ’ and the length of the section simultaneously. These values are
also shown in the ‘Data Info Panel’.

A double click of the left mouse button in the ‘TopView’ window, or
clicking  in the tool info panel, stores the cross-section in a sepa-

rate measurement document. The right mouse button or clicking 
cancels this action.

Cut Out Area

The ‘Cut Out Area’ tool  enables you to create a new measurement
document containing a subsection of an existing measurement. The area
of the subsection is defined by dragging the mouse pointer over an area
in a ‘TopView’ display while holding down the left mouse button. Once
an area is defined, it can be resized by dragging one of its corners, and

FUNCTIONAL REFERENCEMENU TOOLS

CUT OUT AREA



 44

moved to the desired position by dragging its centre point. The ‘Tool
Info Panel’ shows the size and position of this new area and the cursor. A
double click with left mouse button in the view, or clicking  in the
tool info panel, generates a new measurement document containing the
subsection. The ‘Cut Out Area’ tool can be aborted by clicking with the
right mouse button.

  

If just a single mouse click is performed in the active ‘View’, a square
33% of the full area is generated.

Calc Line Roughness

The
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‘Calc Line Roughness’ tool  allows you to calculate certain roughness
parameters of the cross-section that is displayed in the ‘Tool Info Panel’.
The calculated values are displayed in the ‘Result Panel’. The cross-sec-
tion is selected as with the ‘Cross-Section’ tool.

Calc Area Roughness

The ‘Calc Area Roughness’ tool  allows you to calculate the rough-
ness of a selected area. The size of the area is shown in the ‘Tool Info
Panel’ and the actual calculated value is shown in the ‘Result Panel’. The
area is selected as with the ‘Cut Out Area’ tool.

The value displayed in result panel are defined as follows:

The Roughness Average, Sa

The Vally depth, Sv

Sv = lowest value
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Tip:

You can use the  tool to determine the mean height difference be-
tween two plateaus with more accuracy than you can do it with the
‘Measure Distance’ tool. To determine the mean height difference, se-
lect an area on each plateau, and calculate the difference between their
Sm-values.

Correct scan line levels
This tool can be used to flatten the image correctly when the ‘average’
and ‘plane’ LineMath options do not give satisfactory results. This may
occur when the scan lines in different parts of the measurement have a
different average height. An example of such a measurement is shown in
figure Correct scan line levels. To use the tool, draw a line through points
that should have the same height. After clicking , the average level
of each scan line is adjusted so that all points along the drawn line have
the same height. To get useful results, the LineMath option for the dis-
play in which you draw the line should generally be ‘Raw’.

Correct scan line levels, left: uncorrected image with a line through points that should be at
the same height, right: corrected image
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Optical microscope controls (E-AFM)
Controls for the video option are found in the toolbar:

The video option displays the image of the optical microscope built into
the E-AFM.

The video switch buttons

The active video switch button can be either  or .

The video switch buttons are used to set the video channel displayed on
the optional video monitor which is used to observe the sensor through
the magnifying lenses on the E-AFM scanner.

 - the video display is switched to the top view channel .

 - the video display is switched to the side view channel.

Menu Options

The options menu is used to configure the measurement system. Here
the operation mode, calibration, colour palette, various automation pro-
cedures and the scanner simulation mode can be set.
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Config Sensor... (E-AFM)
The cantilever spring constant of the currently used sensor must be en-
tered in the sensor configuration dialog. The software needs the force
constant when performing static mode measurements in order to cali-
brate the force ‘SetPoint’ in the ‘Feedback Panel’. The spring (or force)
constant is supplied with the cantilever (see the label on the cantilever
package).

Microscope Diagnosis... (E-AFM)
The system reports the current status information of the sensor and the
approach platform. If the ‘Sensor Fail’ LED on the E-AFM Drive elec-
tronics is active then more detailed information about the failure is dis-
played in the ‘Microscope Diagnosis’ dialog.

Scan Head Calibration...
In this window the units of all Inputs and Outputs can be configured
individually along with the feedback loop properties which can be loaded
to the scan-head.
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Warning!

Changes to these settings should be performed with great care. False
settings can lead to false interpretation of the data and false operation of
the controller.

Outputs/Inputs/Signal

On the right half of the window the available signals are listed. In the
field ‘Signal’, a ‘Name’ and a ‘Unit’ is assigned to each Input and Out-
put. These names along with their units are used by the program wher-
ever the signals are displayed.

The output for applying a voltage to the tip is called ‘TipVoltage’ with
the E-AFM, and ‘GapVoltage’ with the E-STM. In the following most
of the settings referring to this voltage are used for STM. Therefore the
expression ‘GapVoltage’ is used, but this can also mean ‘TipVoltage’ for
E-AFM users.

Calibration

The ‘Calibration’ values indicate the maximum input and output range
of the respective parameters and are used to calibrate the respective in-
puts and outputs. ‘Maximum’ is set for the positive range of the value,
e.g. for a scan range of 0.5 µm a ‘Maximum’ value of 0.25µm (+0.25µm,
-0.25µm) must be set. ‘Offset’ is the difference in value relative to zero.

FUNCTIONAL REFERENCEMENU OPTIONS

SCAN HEAD CALIBRATION...



 50

In the lower half of the window are the settings which enable the con-
troller’s setting to be adopted so that the measurement system can be
used with different scan-heads.

CtrlInputCorr

CtrlInputPol

Z-AxisPol

Setpoint Setpoint

Z-Axis

ZOutput

Gap/Tip Voltage Gap/Tip Voltage

Channel 0Channel0

+
-
0

+

+

Digital Analog

Slope
generator

±1

±1

+

-

+

Current,
Lever Sig, ...

PI
controller

signal flow

X/Y-axis orthogonality error

If the orthogonality of the scanner is not absolutely perfect, it can be
corrected by entering the appropriate angle for ‘X-Axis rotation’ and ‘Y-
Axis rotation’. The scan axis coordinate system is rotated clockwise. The
figure signal flow shows where the settings take effect.

SetPoint Sign Check

The sign (+/-) of the ‘SetPoint’ is adjusted to the sign (+/-) of
‘GapVoltage’:

none: ‘SetPoint’ and ‘TipVoltage’ have independent signs.

Equal to GapVoltage: ‘SetPoint’ adopts the sign of ‘GapVoltage’.

Complement to GapVoltage: ‘SetPoint’ adopts the opposite polarity to
the ‘GapVoltage’.

CtrlInput correction

Before the input signal is measured the voltage ‘AnalogOut0’, or
‘TipVoltage’, is mixed with the input signal.
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none: the voltage from the scan head’s preamplifier is not
changed.

Add GapVoltage: ‘AnalogOut0’ is added to the output voltage of the
scan-head’s preamplifier.

Sub GapVoltage: ‘AnalogOut0’ is subtracted from the output voltage
of the scan-head’s preamplifier.

CtrlInput pol.

Before the measured signal is passed to the PI-controller it can be in-
verted. Whether this is necessary depends on the type of scan-head.

positive: the signal remains unchanged.

negative: the signal is inverted.

Z-Axis polarity

The output of the feedback loop can be inverted after the alignment of
the scan plane and output to the ‘ScanAxis2’ (with the STM/AFM Z-
axis).

positive: the signal remains unchanged.

negative: the signal is inverted.

Load

A new set of parameters can be loaded from a scanner calibration file.
The default file is ‘uncal.ezh’. After loading the new calibration will be
used after leaving the dialog.

Important!

Always use the proper calibration file which corresponds to the scanner
serial number (e.g. 10-02-007.ezh)

Save As...

The current calibration can be saved in a file.

FUNCTIONAL REFERENCEMENU OPTIONS

SCAN HEAD CALIBRATION...



 52

Access codes...

The scan electronics is upgradable with a second channel input. This
input option must be activated using a software key, which is supplied
on purchase of the 2nd Channel Option.

Enter your access code into the field ‘Edit key for’. Confirm the input
with the ‘Set’ button. The ‘status’ is now ‘valid’.

Note: when the software is operating in  simulation mode, the option
is always ‘active’

Color palette...
In menu item ‘Options->Color palette...’ the color palette is displayed.
The color palette is used to map the display range of the measured val-
ues to a color. 3 different palette types are available:

• Black&White: linear grey scale

• Color: The color selection uses the HSB-color model where
the color (H) is set in ° value. The input is selected
by entering a number or by selecting a color in the
color bar, using the mouse pointer.

• LookUpTable: A user definable palette (with max. 256 color en-
tries) can be selected. Such a palette is an ASCII ta-
ble containing a RGB color values for each color tone.
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Representation of the color palette

Newly defined palette settings are stored by saving the Workspace’s set-
tings.

Auto Adjust Z-Offset
This option is switched on by default. It alters the value of the Z-Offset
after each scanned line, so that the signal is always displayed at an opti-
mum range.

Auto Start/Stop Scan
If the menu option ‘Auto Start/Stop Scan’ is selected, the system auto-
matically starts scanning after approach. Scanning is automatically
stopped when the sensor platform is moved using the functions in the
‘Approach Panel’.

Auto Reload Workspace
If ‘Auto Reload Workspace’ is selected, the software reloads the currently
used workspace configuration file each time an approach is initiated.

This function is very useful to automatically restore a predefined con-
figuration prior to a new measurement.

Auto Reload Parameter
If ‘Auto Reload Parameter’ is selected, the software reloads the currently
used parameter configuration file each time an approach is initiated.

This function is very useful to automatically restore a predefined con-
figuration prior to a new measurement.
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Config COM Port
You can change the number of the RS232 serial interface (COM-port)
to which the easyScan electronics is connected. This is useful when you
did not configure the COM Port correctly on installation, or changed
the COM Port, for example by installing the optional ‘USB Adapter for
easyScan electronics’.

Simulate microscope
Using this item a microscope simulation can be switched on. In the
simulation, most functions of the microscope are performed on a math-
ematically generated surface. Thus, the whole functionality and working
methods of the scanning force microscope can be practised. In this case
the word ‘Simulation’ is displayed in the status bar of the program.

When the easyScan software is started without a microscope connected
or powered on, the following dialog appears:

Click  to automatically turn on the microscope simulation.

Click  if the instrument is connected to a different COM
Port.
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Menu ‘Window’

The first section determines the arrangement of the measurement docu-
ment windows (Cascade, Tile).

The ‘Toolbar’ and ‘Status Bar’ can be shown by checking these entries.

The Status bar displays the state of the instrument, whether the micro-
scope simulation is active (‘Simulation’) or not (‘Online’), the active
workspace .ezw file, the active parameter .ezs file, active scanner calibra-
tion file <serial number>‘.ezh’ and the instrument type.

The last section of the window menu is a list of all measurement docu-
ment windows.

Menu ‘?’

‘About easyScan...’
In the ‘About...’-window you find the software version as well as the
serial number of the connected scan electronics.

FUNCTIONAL REFERENCEMENU ‘?’

‘ABOUT EASYSCAN...’



 56

If the microscope simulation is active ‘SerialNr. 000-00-000’ is displayed.
The Nanosurf Web-site and contact address for information and soft-
ware updates are displayed here.

FUNCTIONAL REFERENCE MENU ‘?’

‘ABOUT EASYSCAN...’



57

Programs for further data processing

Mountains SPM
The Optional “Mountains SPM” software package offers a powerful and
extensive set of analysis functions. Its unmatched reporting capabilities
offer the quickest path from measurement to documentation. ‘.ezd’ files
can directly be opened via its studiable explorer or the ‘File/Open a
studiable...’ menu in version 3.1.7 and newer.

PROGRAMS FOR FURTHER DATA PROCESSINGMOUNTAINS SPM
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SPIP™
The ‘Scanning Probe Image Processor SPIPTM’ software from Image Me-
trology (www.imagemet.com) offers SPM specific functions to labora-
tory users that value powerful analysis more than ease of use.

Freeware
Export measurement data to the freeware using the menu ‘File->Export-
>View as...’ and select ‘Datafile 8-Bit’ as data type .

The following freeware is available in the Internet:

PC: ‘Image Tool’ source: http://ddsdx.uthscsa.edu

Import your data using ‘File->Import’. Enter the number of measured
points  in the field ‘ImageSize’. Set ‘PixelDepth’ to ‘Greyscale 8-Bit’ and
‘Scan Line Padding’ to ‘Padded to 8 Bit boundaries’.

PC: ‘Scion Image’ source: http://www.scioncorp.com

Import your data using ‘File->Import’. Click the ‘Set...’ button in the
‘Import’-dialog, and enter the number of measured points. Set the data
type to ‘Custom’, ‘8-Bit’.

Mac: ‘ImageSXM’ source: http://reg.ssci.liv.ac.uk/

equivalent to ‘Scion Image’
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